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SEIKO INSTRUMENTS USA INC. SOFTWARE LICENSE AGREEMENT

IMPORTANT!  The enclosed software is licensed only on the condition that the licensee (referred to in this Agreement as "YOU") agrees 
with Seiko Instruments USA Inc. (referred to in this Agreement as "SIU") to the terms and conditions set forth in the following legal 
agreement.  READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY.  YOU WILL BE BOUND BY THE TERMS OF THIS 
AGREEMENT IF YOU OPEN THE SEALED PACKAGE.  If You do not agree to the terms contained in this Software License Agreement, 
please return this package UNOPENED to your dealer and your license fee will be refunded.
SIU will grant You a nontransferable, nonexclusive license to use the enclosed software (the "Licensed Software") and the accompanying 
documentation (the Licensed Software, the media embodying the Licensed Software, and the documentation are referred to in this 
Agreement as the "Licensed Materials"), if You agree to the following terms and conditions:
1. TERM; TERMINATION
This Agreement is effective from the date on which You open the package containing the Licensed Materials.  This Agreement may be 
terminated by You at any time by destroying the Licensed Materials, together with all copies.  It will also terminate automatically without 
notice if You fail to comply with any term or condition of this Agreement.
2.  LICENSE GRANT
SIU grants to You the right to use the Licensed Software in conjunction with a single Smart Label Printer (hereinafter "Printer") as noted 
herein.  YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE LICENSED MATERIALS, IN WHOLE OR IN PART, EXCEPT AS 
PROVIDED IN THIS AGREEMENT.
3.  OWNERSHIP
The Licensed Materials are the sole and exclusive property of SIU.
4.  COPY RESTRICTIONS
You may make one (1) copy of the Licensed Software for backup purposes. In no event does the copying permitted under this Agreement 
include the right to decompile, disassemble, or electronically transfer the Licensed Software, or to translate the Licensed Software into 
another computer language.  You may not copy the documentation.
You agree to include the copyright notice set forth on the label of the media and embodied in the Licensed Software on any copy of the 
Licensed Software in any form, in whole or in part.
5.  PROTECTION AND SECURITY
You agree to use your best efforts and take all reasonable steps to safeguard the Licensed Materials to ensure that no unauthorized 
person shall have access thereto and that no unauthorized copy, publication, disclosure or distribution, in whole or in part, in any form 
shall be made.  You acknowledge that the Licensed materials contain valuable, confidential information and trade secrets and that 
unauthorized use and/or copying are harmful to SIU.
6.  DUTY TO BACKUP DATA
IT IS YOUR RESPONSIBILITY TO MAINTAIN PERIODIC BACKUP COPIES OF ALL DATA AND PROGRAMS USED IN 
CONJUNCTION WITH THE LICENSED SOFTWARE TO PREVENT CATASTROPHIC LOSS.
7.  LIMITED WARRANTY
The only warranty SIU makes to You in connection with the Licensed Materials is that the media on which the Licensed Software is 
recorded will be replaced without charge, if SIU in good faith determines that it was defective and not subject to misuse, and if the media 
and proof of purchase of the Printer are returned to SIU or the dealer from whom it was obtained within ninety (90) days of the date of 
purchase. Because SIU cannot know the purposes for which You acquired the Printer or the uses to which You will put the Printer or the 
Licensed Software, You assume full responsibility for the selection of the Printer and Licensed Software and for their installation and use 
and the results of that use.
8.  WARRANTY DISCLAIMERS; LIABILITY LIMITATIONS
SIU MAKES NO WARRANTY OR REPRESENTATION WITH RESPECT TO THE LICENSED SOFTWARE AND IT IS LICENSED "AS 
IS."  THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, AND ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID.
YOU AGREE NOT TO USE THE LICENSED SOFTWARE IN ANY SITUATION WHERE SIGNIFICANT DAMAGE OR INJURY TO 
PERSONS, PROPERTY OR BUSINESS COULD OCCUR FROM A SOFTWARE ERROR.
YOU ASSUME ALL RISK AS TO THE SELECTION, USE, PERFORMANCE AND QUALITY OF THE LICENSED MATERIALS.  IN NO 
EVENT WILL SIU OR ANY OTHER PARTY WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THE 
LICENSED MATERIALS BE LIABLE FOR SPECIAL, DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
INCLUDING LOSS OF PROFITS OR INABILITY TO USE THE LICENSED MATERIALS, EVEN IF SIU OR SUCH OTHER PARTY HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES IN NO EVENT SHALL SIU' S OR SUCH OTHER PARTY' S LIABILITY 
FOR ANY DAMAGES OR LOSS TO YOU OR ANY OTHER PARTY EXCEED THE PURCHASE PRICE PAID FOR THE PRINTER 
CONTAINING THESE LICENSED MATERIALS.
Some states and/or countries do not allow limitations on how long an implied warranty lasts and some states and/or countries do not 
allow the exclusion or limitation of incidental or consequential damages, so the above limitation and exclusion may not apply to you. This 
warranty gives you specific legal rights, and you may also have other rights which vary from state to state and/or country to country.
9.  GENERAL
If any provision or portion of a provision of this Agreement is determined to be invalid or unenforceable, it shall be deemed omitted and 
the remaining provisions of this Agreement shall remain in full force and effect. 
This Agreement is governed by and construed in accordance with the laws of the State of California.  Any suit brought with respect to this 
Agreement may be brought ONLY in Santa Clara County, California USA and must be filed no later than one (1) year after the purchase 
date of the Printer or subsequent software upgrade.
This Agreement constitutes the entire agreement between the parties with respect to the subject matter hereof, and all prior agreements, 
representations, statements and undertakings are hereby expressly canceled.
Should you have any questions regarding this Agreement, you may contact SIU by certified mail at the most convenient address listed 
inside the back cover of the Licensed Software user' s guide.
10.  U.S. GOVERNMENT RESTRICTED RIGHTS
The Licensed Materials are provided with RESTRICTED RIGHTS.  The use, duplication, or disclosure by the Government is subject to 
restrictions as set forth in subdivision (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013.  The 
contractor/ manufacturer of this Software is SEIKO INSTRUMENTS USA INC., 1130 Ringwood Court, San Jose, California 95131 USA.
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FCC Compliance Statement 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential application. This equipment generates, uses and 
can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications not expressly approved by Seiko Instruments could void the user' s 
authority to operate the equipment.

Applicable EC Directives and Standards

Directive Title

89/336/EEC EC Electromagnetic Compatibility Directive
73/28/EEC EC Low Voltage Directive

Standards Title

EMC EN55022 classB /95
EN50082-1/92, IEC801-2/84, IEC801-3/84, IEC801-4/88

LVD EN60950/87

Copyright
All rights reserved. No parts of this publication may be reproduced, stored in a retrieval system, 
or transmitted, in any form, or by any means, electronic, mechanical, photocopying, recording, 
or otherwise without the prior written permission of Seiko Instruments USA Inc. No patent 
liability is assumed with respect to the use of information contained herein. While every 
precaution has been taken in the preparation of this publication, Seiko Instruments USA Inc. 
assumes no responsibility for errors or omissions. Nor is any liability assumed for damages 
resulting from the use of information contained herein. Further, this publication and features 
described herein are subject to change without notice. 
Copyright •  1989-1999 by Seiko Instruments USA Inc.
1130 Ringwood Court, San Jose, CA 95131. All rights reserved.

Smart Label Printer •  1992-1999 Print Things. All rights reserved.
Smart Label Printer 120/220 User Guide by Prestige Publications, Milpitas, CA

Manual Part Number:  22-83000-03 Printed in USA



Trademark Information
IBM is a registered trademark of International Business Machines Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
SII and the SII logo are registered trademarks of Seiko Instruments Inc.
Smart Label Printer is a registered trademark and SmartLabels, Smart Label Icons, SmartCopy, 
SmartCapture and SmartCode are trademarks of Seiko Instruments USA Inc.

Other products mentioned in this guide are trademarks or registered trademarks of their 
respective companies.
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Important Safety Instructions

The following symbols are used in this User Guide.

WARNING.  Warning statements are used to indicate 
actions that may result in risk of severe personal injury or 
loss of life.

CAUTION.  Caution statements are used to indicate 
actions that may result in damage to the printer or other 
property, or may result in risk of minor personal injury.

Warning

1 Use only the AC adapter provided with this printer, or an 
AC adapter that has been approved by Seiko Instruments 
for use with this printer. Use of an incorrect AC adapter 
may cause risk of overheating or fire.

2 Do not bend or place a heavy object on the power cord 
as it could damage the cord and result in risk of electric 
shock or fire. Do not use the power cord if damaged or 
frayed.

3 The thermal print head may become quite hot after print-
ing. Be careful when changing labels and cleaning the 
thermal head.

Caution

1 Never insert objects of any kind into this printer as they 
may touch dangerous voltage points or short out parts, 
and may result in a risk of fire or electric shock. Never 
spill liquid of any kind on the printer.

2 This printer contains no user-serviceable parts. Do not 
attempt to service the printer yourself as this can expose 
you to dangerous voltage points or other risks. Repair 
service should be performed by a trained technician.

3 Do not use this printer near water or in extreme 
humidity.
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4 Be sure to hold only the connector end of the power 
cord or interface cable when disconnecting. Repeated 
pulling on the cable could damage the cable.

5 If any of the following conditions occur, turn off the 
printer and unplug the power cord from the power 
outlet:

■ The power cord is damaged or frayed.

■ Liquid has been spilled into the printer or the printer 
has been exposed to rain or water.

■ The printer does not recover from an error or the 
printer does not operate normally when the operating 
instructions are followed.

■ The printer exhibits a distinct change in performance, 
such as emitting a strange noise, odor or smoke.

Installation
For best performance, we recommend that you install your 
printer on a flat surface in a location that satisfies the 
following environmental conditions:

■ Not subject to vibration

■ Not exposed to direct sunlight

■ Dust-free

■ Condensation-free

■ Temperatures: 59 to 95°F  (15 to 35°C)

■ Humidity: 30% RH to 80% RH (non-condensing)
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User Guide i

About This Guide

As you‘ll soon realize, the Smart Label Printer® is easy to set 
up and use. Chances are, once you’ve read what you need 
to know in order to get going, you won’t have to use this 
guide except as a quick reminder or a reference. 

This guide will help you set up your SLP 120 or 220, install 
the software, and use your SLP to make labels.

In writing this guide we assume that you are familiar with 
common operations using Microsoft® Windows® 95, 98 or 
Windows NT on an IBM®-compatible PC.

The following conventions are used to convey information 
in this guide:

■ Commands you choose from the menus and items you 
select appear in italics with initial capital letters.

Example:  Choose Print from the File menu.

■ Text we ask you to type appears in bold.

Example: Type A:SETUP.
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ii Smart Label Printer Models 220 and 120

This guide has three chapters and three appendices:

■ Chapter 1, Introduction, provides some general informa-
tion about the SLP 120/220 and the Smart Label program.

■ Chapter 2, Getting Started, provides instructions for con-
necting the SLP 120/220 to an IBM-compatible PC, load-
ing labels into the printer, and installing the Smart Label 
program. It also describes the toolbar functions, how to 
prepare and print labels, and how to use on-line help.

■ Chapter 3, Changing Labels and Printer Care, provides 
information for replacing a label roll and taking care of 
your SLP. 

■ Appendix A, Specifications, provides SLP 120/220 specifi-
cations and the connector pin assignments.

■ Appendix B, Commonly Asked Questions and Answers, 
provides a list of questions and answers that can help 
you resolve problems.

■ Appendix C, Technical Support and Service, describes 
how to determine if your SLP needs service and how to 
contact Seiko Instruments for Technical Support and 
repairs.

■ Appendix D, Ordering Labels and Parts, provides infor-
mation for ordering SmartLabels and replacement parts 
and accessories.
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About Your Smart Label Printer
The Smart Label Printer® from Seiko Instruments replaces 
the typewriter for many daily tasks. These compact printers 
with their integrated Smart Label software print high-quality, 
personalized labels—eliminating the need for handwritten 
or typewritten envelopes and ending the hassle of using 
your regular printer to print labels for envelopes, file 
folders, bar codes, ID badges and more. 

The SLP is the best way of printing one-at-a-time labels 
instantly without the setup hassle and wasted labels 
experienced when making labels with a regular printer. 
Direct thermal printing technology does not use ink, toner 
or ribbon, just labels. The SLP produces fast, laser-quality 
output on a variety of label sizes with the ability to print 
text, photo-like graphics, POSTNET codes and bar codes. 

The Smart Label software features a WYSIWYG editor, 
SmartCapture™ and SmartCopy™ to capture text and 
addresses right off your screen, built-in database, a 
Windows print driver, and background printing. It uses 
TrueType fonts and imports logos, graphics, and text files.

With the wide variety of available SmartLabels™, you can 
use your SLP to create labels for just about anything. Here 
are some examples:

...and much more.

■ Envelope labels ■ Bar code labels

■ File folder labels ■ Diskette labels

■ Name tags ■ Rotary file cards

■ Shipping labels ■ Videocassette labels

■ Storage container labels ■ Binder labels

■ Notebook labels ■ Shelf labels
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Software Features
The Smart Label program provides a rich set of features to 
simplify your labeling needs.

■ 32-bit architecture designed to work in Windows 95, 98 
and Windows NT with support for long file names.

■ WYSIWYG editor displays labels as they will print.

■ Prints in background so you can work with other applica-
tions while labels are printing. Print labels one at a time 
or whole mailing lists.

■ Object-oriented user interface makes it easy to include 
text, pictures, bar codes, etc. on your label.

■ Mixed text possible within each text object—different 
font types, sizes and styles (bold/italic/underline) can be 
included on a single line.

■ Shrink-to-fit and word wrap ensure that addresses and 
other text fit on the label.

■ SmartCapture and SmartCopy capture text from Windows 
applications, saving time and eliminating retyping.

■ Customizable Smart Label Icons™ make it easy to format 
different types of labels.

■ Built-in database to save labels and formats in user-defin-
able database categories.

■ Find feature makes it easy to locate saved labels by label 
name, database field, whole words or sounds-like word if 
you aren’t sure of the spelling.

■ Multiple user feature allows each user to have a unique 
setup and Smart Label start-up icon. 

■ Contact-based records updated automatically from label 
addresses.
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What You Need
In order to use your SLP and software, you need to have the 
following: 

■ An IBM PC or 100% compatible computer

■ An 80386 or higher processor

■ 4 MB of available Random Access Memory (RAM)

■ An available RS-232C serial port

■ 5 MB available hard disk space

■ VGA or higher resolution graphics card

■ A mouse or other pointing device

■ Microsoft Windows 95, 98 or Windows NT 4.0
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A Word About Labels
For best results we recommend the use of Seiko Instruments 
SmartLabels. Other brands may not be engineered to 
provide optimum, trouble-free results with your SLP; they 
may not work with your printer or they may damage it and 
void your warranty. Be sure to look for the following Seiko 
Instruments SmartLabels logo on the package when you 
buy labels. 

SmartLabels are available in a wide variety of sizes and 
colors to properly label almost anything.

The SmartLabels have a sensor mark on the backing of each 
label that the SLP 120/220 uses for top of label alignment. 
Check to be sure the labels have this mark before loading 
them into the SLP.

Note...  Older SmartLabels did not have this sensor mark. Be 
sure that the SLP 120 and 220 are listed as supported 
printers on the SmartLabels package.

Caring for Labels
The labels are sensitive to heat, moisture, and light. With 
this in mind: 

■ Store labels in a cool, dry place.

■ Do not scratch or rub labels with a hard object.

■ Keep organic solvents away from labels.

Sensor mark
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Installing the SLP 120 or 220
Here, you’ll find out how to unpack and set up your new 
SLP. As part of the setup process, you’ll load a roll of 
standard address labels and run a quick test.

Unpacking the SLP
Carefully remove the printer and its components from the 
box. It’s a good idea to save the box and packing materials 
in case you need to store or ship the printer. Make sure you 
have all of the following items.

■ A Smart Label Printer 120 or 220

■ Smart Label software

■ A serial cable to connect the SLP to your IBM-
compatible computer

■ A power cord

■ An AC adapter

■ A roll of SmartLabels

■ User Guide

Smart Label Printer
120 or 220*

SmartLabels

Serial cable

Power cord

Smart Label
software

User
Guide

*Smart Label Printer 220 shown.

AC adapter
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Connecting the SLP to a Power Outlet
Now you’re ready to connect the SLP to a power outlet: 

1 Plug the power cord into the AC adapter.

2 Plug the AC adapter cable into the jack at the rear of the 
SLP.

3 Plug the power cord into a power outlet.

4 Turn the SLP on by pressing the power button.

When you turn the printer on, the status light flashes 
green. This is just to let you know there are no labels in 
the printer. 

Form feed button

Status light

Power button
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Connecting the SLP to an IBM-compatible PC
Use the serial cable provided with the SLP 120/220 to 
connect the SLP to your computer. It has a telephone-style 
connector at one end and two computer connectors at the 
other end.

CAUTION:  Connecting or disconnecting the interface 
cable while the printer is turned on may damage the 
printer.

Follow these steps:

1 Make sure that the SLP is turned off.

When the power is on, the status light on the front of the 
printer is lit.

2 Plug the telephone-style connector into the jack on the 
rear panel of the SLP.

3 Plug the other end of the cable — either the 9- or 25-pin 
connector as appropriate — into a serial port on your 
computer.

Note… Serial ports are also called COM ports — COM1, 
COM2, COM3, or COM4. If your COM ports are all in use, 
purchase either another serial port or an “A-B” switch box 
to connect the SLP and another device to the same port. 
The Seiko Instruments’ serial-to-parallel converter can be 
used if you have an available parallel port (see Appendix D, 
Ordering Labels and Parts for ordering information).

- OR -

PC Serial port

Do Not Use 
Both 
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Loading a Roll of Labels
Follow the instructions below to load a roll of standard 
address labels. Instructions on loading other label types 
appear in Chapter 3.

Prepare the roll of labels

1 Remove the sticker from the beginning of the roll of 
labels. 

Note...  Check to be sure there is a black sensor mark on 
the label backing as illustrated on page 2-3.

2 If needed, cut between the labels to create a “leader.”

If the end of the roll is not prepared as shown above, cut 
between the labels leaving as much backing as possible 
on the end of the roll to act as a leader.

Load the roll of labels

1 Make sure the power cord is connected and the printer is 
turned on.

The green status light should be flashing.

2 Lift the base of the clear plastic label cover and rotate it 
open. 

Roll

Prepared end Cut here

RollWaste

Spindle
Label
cover
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3 Remove the spindle from the SLP and insert the label roll 
on the spindle.

4 Insert the labels and spindle into the SLP. If using an SLP 
220, adjust the guides to fit the labels as shown below.

5 Insert the free end of the label roll, label side down, into 
the slot on the back of the printer. Push the label stock 
into the slot until you feel a slight resistance. Continue 
pushing gently. The SLP automatically feeds the labels 
through and aligns the end in the exit slot.

If the label end doesn’t appear through the slot, press 
and release the form feed button to advance the labels.

SLP 220

SLP 120
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6 Close the label cover.

Testing the Printer
A quick test lets you know your printer is operating 
properly and that the labels are loaded correctly. Here’s 
how to proceed:

1 Press and hold the power button for 2 seconds to turn 
the printer off.

2 Press and hold the form feed button while you press and 
release the power button. If the test is successful, the SLP 
120/220 will print a test label.
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Installing the Smart Label Program
1 Start Windows.

2 Insert the Smart Label installation disk 1 or CD-ROM into 
the appropriate drive.

3 Click the Start button then point to Settings and choose 
Control Panel. The Control Panel window appears.

4 Double-click Add/Remove Programs. The Add/Remove 
Programs Properties dialog box appears.

5 Click the Install button. A dialog box appears asking you 
to insert the floppy disk. 

6 Click the Next button. The drive and SETUP.EXE file are  
automatically selected and shown in the command line 
box. 

7 Click the Finish button. Follow the directions on the 
screen to complete the installation of the program.
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Starting the Program
If you installed a desktop or Start menu shortcut during 
installation, double-click the shortcut icon.

To use the Programs menu

Click the Start button, point to Programs then Smart Label 
Printer and choose the Smart Label program.

Updating a Previous Version
Before you can use labels that were saved from a previous 
Smart Label Printer software version, you must first import 
them into Smart Label program. The labels import with the 
same categories as the previous version. Address labels are 
automatically entered into the Contact Information fields.

1 Select the library that you want to import the files into. 
Initially the default library (LABELS.SLL) is open. To 
import into a different library, follow the directions in the 
on-line help.

2 Choose Library then Import from file from the Label 
menu. The Import File Wizard appears. Click the Next 
button.

3 Select the previous Smart Label Printer type from the list 
and click the Next button.
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4 Follow the directions on the screen to select the label file 
and the labels within the file that you want to import.

The labels import into the previously assigned categories.
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Changing the COM Port
The COM port connection for the SLP is automatically 
detected and selected during installation. If you change the 
SLP to a different COM port after installation, you will need 
to change the setting in the Smart Label program.

1 Choose Printer setup from the Label menu.

2 Select the new COM port in the Printer Setup dialog box 
and click OK.

If you have trouble using the new COM port, check the on-
line help.
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Using the Toolbar
The toolbar buttons provide quick access to commonly 
used features. Simply click a button to initiate the action. 
The name of the button appears when you position the 
cursor over it.

Basic Function Buttons

New Label Opens a new label.

Open Label Opens a dialog box where you 
select the label that you want to 
open.

Note...  To locate a label by search-
ing for words within a label, 
choose Find from the Label menu.

Save Label Saves the active label. The first 
time a label is saved a dialog box 
appears where you assign a label 
name and select a category.

Print Label Prints one copy of the active label. 
Use File menu commands to print 
multiple copies, saved labels, and 
files such as mailing lists.

Text
Capture

This button appears in the Notifica-
tion area of the Windows Taskbar. 
It is used to SmartCopy or 
SmartCapture address text from 
other programs.
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Smart Label Icons

Object Buttons
Select and add objects to the label. To open the Properties 
dialog box, click the right mouse button and select 
Properties or choose Properties from the Object menu.

Clicking one of the Smart Label Icons immediately 
changes the label format to the format assigned to 
that icon. Initially the Smart Label Icons are 
assigned the following formats and icons. 

■ Address label with U.S. POSTNET code

■ Shipping label with return address

■ General purpose label

■ File folder label

■ Invitation mailer label

■ 3-1/2” backup disk label

■ Name badge label

The Smart Label Icons can be customized to suit 
your specific needs.

Select This button is used to select objects 
and text. To select objects, click the 
object. To select text, click and drag 
across text.

Add Smart Text Since a label can only have one 
Smart Text object, this button is 
only available when the initial Smart 
Text object has been deleted. Click 
this button and drag in the label to 
add the Smart Text object. Type text 
into the object. 

Add Picture Click this button and drag in the 
label to add a Picture object. Select 
the picture source from the dialog 
box that appears.
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Contact Information Button

Add Format 
Text

Click this button and drag in the 
label to add a Format Text object. 
Type text into the object. To utilize 
text from the Contact Information 
dialog box, choose Insert Field from 
the Edit menu and select the fields 
in the order that you want them 
inserted. Type any punctuation, text 
or spacing that you want to use 
between the fields.

Add Bar Code Click this button and drag in the 
label to add a Bar Code object. 
Type the bar code number into the 
dialog box that appears.

Add Return 
Address

Click this button and drag in the 
label to add a Return Address 
object. Select the return address 
from the dialog box that appears. 
Click New to enter a new address.

Add Frame Click this button and drag in the 
label to add a Frame object. To 
change the border, click the right 
mouse button and choose Change 
Frame to open the Frame Properties 
dialog box.

Contact 
Information

Opens the Contact Information dia-
log box. Use the dialog box to:

■ Verify the address fields that were 
automatically entered.

■ Enter other information such as 
the phone number.

■ Modify information.

■ View information

slp120-2.bk  Page 16  Friday, March 3, 2000  12:40 PM



Chapter 2 Getting Started

User Guide 2-17

Creating New Address Labels
The basic steps for preparing and printing address labels are 
described below. The on-line help describes how to print 
address labels using files created in other programs.

Step 1 Create a New Label   

1 Click the New Label button to begin a new label.

2 Type the address 

-Or-

Use SmartCopy or SmartCapture to copy address text 
from another program. See on-line Help for details.

3 To customize the label, click a Smart Label Icon.

See “Changing the Label Type” later in this chapter if you 
want to use a different label type.

4 To add reference information such as phone numbers:

Click  and make the desired entries.

Step 2 Print the Label
Click the Print button to print the label.

Step 3 Save the Label
If you want to use the label in the future:

1 Click the Save Label button. The Save As dialog box 
appears. The first line of the address is shown in the 
Label Name box. Accept this name or type a different 
label name.

2 Click the Swap Names button to reverse the first and last 
name.

3 Select the category name that you want to use for the 
label and click OK.

Note...  To modify the category names or create new 
categories, choose Library then Define category names from 
the Label menu.
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Printing Saved Labels
After labels are saved, they can be reprinted as needed 
without opening them in the Smart Label program.

1 Choose Print Selected Labels from the File menu. The 
Print Selected dialog box appears.

2 Select one or more categories from which you will select 
labels for printing.

3 Select the desired format option.

4 Click OK to print the labels.

To pause, cancel or monitor printing, click the Smart Label 
Print Manager in the Windows Taskbar. Printing can also be 
suspended by pressing and releasing the power button.
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Preparing Other Labels
The default Smart Label Icons provide sample formats for a 
variety of different labels. It is easy to customize these 
formats with your company logo, return address, etc. If you 
want to create a label type that isn’t included, add the 
objects and modify the label as described below. 
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Using Smart Label Icons
Smart Label Icons format the active label with a different 
format. 

1 Open a new label or a label that contains text that you 
want to use for a different type of label; e.g., the contents 
of an address label can be used to create a file folder 
label.

2 Click the Smart Label Icon for the type of label that you 
want to prepare. Click the asterisk button to select a for-
mat that hasn’t been assigned to a Smart Label Icon.

3 If the Smart Text object is empty, type the text into the 
object. 

Smart Text objects that contain fields automatically insert 
contact information from the active label.

Modifying the Objects
In addition to the Object menu commands, there are 
context menus that provide commands for modifying 
objects and the label settings. 

■ When the pointer is positioned on an object, clicking the 
right mouse button opens the context menu that contains 
commands for working with that object.

■ When the pointer is positioned outside objects on the 
label, clicking the right mouse button opens a context 
menu that contains commands for printing the label, 
opening a new label, and opening the Label Properties 
dialog box.

Note...  If you have difficulty selecting an object in the label, 
choose the object from the list at the bottom of the Object 
menu.

Changing the text and pictures

■ Format Text objects. Select the text that you want to 
change and type the new text.

■ Return Address objects. Choose Change Return Address 
from the context menu or choose Properties from the 
Object menu. Enter your return address into the dialog 
box that appears.
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■ Picture objects. Choose Change Picture from the context 
menu or choose Properties from the Object menu. Select 
the picture source from the dialog box that appears.

Changing object properties

1 Choose Properties from the object context menu or the 
Object menu.

2 Select the options that you want to change in the Proper-
ties dialog box.

Moving and resizing objects

1 Select the object. Handles appear around the object when 
it is selected.

To select Smart Text and Format Text objects, choose 
Move/Resize from the context menu. 

2 To resize objects, drag the handles.

3 To move objects, position the pointer over the object 
until it changes to a crossed arrow. Drag the object to the 
desired position. 

Deleting objects

Choose Delete from the context menu or select the object 
and choose Delete from the Object menu.

Adding Objects

1 Click one of the add object buttons in the toolbar or 
choose Add and the object type from the Object menu.

2 Position the pointer where you want to insert the object 
and drag to draw the object.

3 If a dialog box appears, select the options or enter infor-
mation for the object.
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Changing the Label Type
To use a different label type, choose Properties from the 
label context menu or the Label menu and select the label 
type from the list. The new label type is reflected in the 
window when you click OK.

Saving the Format
Changes to the label’s format can be saved to an existing 
format or as a new format.

1 If you want to save changes to one of the default Smart 
Label Icons, position the pointer over the icon to display 
the format name.

2 Choose Save format from the Format menu. The Save 
Format wizard appears. Click the Next button to move 
through the wizard.

3 Enter a new format name or select an existing format 
from the list.

4 If saving a new format, select an icon to represent the 
format.

5 To assign a new format to a Smart Label Icon, select the 
icon that you want to replace.
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Using On-Line Help
The on-line help provides detailed instructions for creating 
labels, customizing format, SmartCopy or SmartCapture, 
printing, and label database functions.

You access Help through the Help Topics command on the 
Help menu.

Use the Help Topics screen to jump to topics that tell you 
how to use the program, or to get quick access to other 
reference topics.

Contents Tab
The Contents tab lists topics grouped by subject. Double-
click a book icon to view the contents for that subject. 
Double-click a topic with a question mark icon to view the 
help text. 

After viewing help text, click Help Topics to return to the 
Contents. 

Note...  If the topic contains green underlined text, click the 
green text to view help text for that topic.
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Index Tab
Click the Index tab to find specific topics in an alphabetical 
list. To quickly locate a topic, type the first few letters of the 
topic. Double-click the topic to view help text.

Find Tab
Click the Find tab to find all topics that contain a word or 
phrase. Type the word or phrase to list topics. Double-click 
a topic to view help text.
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Overview
The SLP 120/220 uses advanced thermal print technology to 
provide crisp, high-contrast printing. There are no ribbons 
or cartridges to replace.

An important consideration... For best results we 
recommend the use of Seiko Instruments SmartLabels. 
Other brands may not be engineered to provide optimum, 
trouble-free results with your SLP; they may not work with 
your printer or they may damage it and void your warranty. 
Be sure to look for the Seiko Instruments SmartLabels logo 
when you buy labels.
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Caring for Your Printer
Your SLP 120/220 is a high-precision device that’s designed 
for trouble-free operation. Just follow these few 
precautions:

■ Important… The SLP 120/220 is designed for use only 
with Seiko Instruments SmartLabels. Use of improper 
labels may damage the printer. 

■ Don’t operate the printer in a dusty environment.

■ Keep the printer out of direct sunlight. 

■ If you are printing more than one label at a time, guide 
the labels over the front of the label cover as they exit, 
making sure that they don’t curl under the cover and 
loop through and into the feed slot. 
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Off Line and On Line Mode
Pressing and releasing the power button toggles the printer 
between off line and on line mode. An amber status light 
indicates that the printer is off line. There is no communica-
tion with the computer when the printer is off line.

This feature is a handy way to stop printing so you don’t 
waste labels while you delete labels from the print queue. 

slp120-2.bk  Page 4  Friday, March 3, 2000  12:40 PM



Chapter 3 Changing Labels and Printer Care

User Guide 3-5

Changing a Label Roll
This procedure describes how to remove and replace label 
rolls.

■ You can load a different type of label at any time — you 
don’t have to wait until all of the labels have been used.

■ When you run out of labels, the green status light on the 
front of the SLP flashes. If printing is in process, a mes-
sage appears telling you that the printer is out of labels.

Removing the Old Roll

CAUTION:  DO NOT pull on the labels to remove them 
from the printer. This may cause labels to get stuck 
inside the printer.

1 Tear off any printed labels. If labels aren’t torn off, they 
may get jammed when you perform step 2. 

2 Press and hold the form feed button. The labels will 
reverse out of the SLP.

Loading the New Roll
Prepare the new label roll and load the labels as described 
in Chapter 2.
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Adjusting the Position of Labels
If you find the labels are advancing at an angle, it’s easy to 
realign them. Follow these steps:

1 Remove the print engine cover by grasping it on the top 
and tilting it toward you.

2 Release the pressure on the label stock by moving the 
platen release lever toward the back of the SLP.

3 Realign the label stock so it is straight.

4 Return the platen release lever to the locked position.

5 Make sure the labels feed through the slot.

6 Insert the tabs on the lower edge of the print engine 
cover into the slots on the SLP and push the top edge for-
ward until the cover snaps into place.

Remove the print engine cover

Release the platen lever
and rotate the platen knob
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Removing Stuck Labels
If a label becomes stuck in your SLP, remove it as follows:

1 With a pair of scissors, cut the label stock between the 
label roll and the label slot at the back of the printer.

2 Remove the print engine cover by grasping it at the top 
and pulling the top toward you.

3 Release the pressure on the label stock by moving the 
platen release lever toward the rear of the printer.

4 Remove the stuck label by turning the platen knob coun-
terclockwise.

5 If the label — or pieces of the label — stick to the platen, 
use a small amount of isopropyl rubbing alcohol on a 
cotton swab to dissolve the adhesive on the back of the 
label.

CAUTION:  DO NOT touch the print engine. It may be 
hot.

6 Once you have removed any remaining pieces of label, 
return the platen release lever to the locked position.

7 Insert the tabs on the lower edge of the print engine 
cover into the slots on the SLP and push the top edge for-
ward until the cover snaps into place.
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Smart Label Printer 120/220 Specifications
The SLP is a compact printing device ideally suited for label 
printing applications. There are no built-in fonts and any 
text must be converted to a bitmap image by a host 
computer or device for printing on the SLP.

Developer information can be found on our 
http://www.seikosmart.com web site.

Printer

    Technology Direct thermal

    Resolution 203 dpi (8 dots/mm)

    Max. Paper
    Width

Model 120 1.1 in. (28mm)
Model 220 2.28 in. (58mm)

    Max. Printable
    Width

Model 120 0.94 in. (24mm)
Model 220 1.89 in. (48mm)

    Print Speed 3.5 seconds
average speed, standard address label

    Interface RS-232

    Power Universal AC adapter
Input: AC 90-240V, 50/60 Hz
Output: DC12V 4A (max.)

    Dimensions 4.92 (W) x 7.68 (D) x 6.5 (H) in.
125 (W) x 195 (D) x 165 (H) mm

    Weight About 1.15 lbs. (520 grams)

Environment

    Temperature Operating: 15 to 35°C (59 to 95°F)
Storage: -20 to 60°C (-4 to 140°F)

    Humidity Operating: 30% RH to 80% RH (non-
condensing))

Storage: 30% RH to 90% RH (non-
condensing)
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Status Light Indicators

* The number refers to the number of blinks.

LED Indicator State

Off Power off/Stand-by

Steady Green On-line

Steady Amber Off-line

Blinking Green 1* No labels

Blinking Green 2* Print head up

Blinking Amber 1* Label jam

Blinking Amber 2* Buffer overflow

Blinking Red 1* Temperature error

Blinking Red 2* Voltage error

Blinking Red 3* Print head error
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 IBM-compatible Connector Pin Assignments
The following chart shows the IBM-compatible connector 
pin assignments for the SLP 120/220.
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Q Will my labels fade over time?

A Labels use a thermal-sensitive paper to create the image. 
Heat applied to the paper causes a chemical reaction to 
generate black dots at the points where heat was 
applied. This technique avoids using messy inks and 
ribbons. Because the paper is heat-sensitive, it is 
possible for a label to darken if exposed to high heat or 
very bright light for an extended period of time. It is also 
possible for certain plasticizers in some plastic binders to 
cause a chemical reaction which results in the image 
fading over time. Placing another adhesive (perhaps 
another label) between the vinyl surface and the label 
may help minimize this type of fading.

In general, labels will last for years if they aren’t 
subjected to the above conditions. The label material is 
much more stable than Fax paper due to the special 
formulation and coatings used by Seiko Instruments.

Q How many labels can I save?

A The number of labels you can save is limited only by the 
amount of disk space in your computer.

Q I just bought an SLP 120/220, but there is no place to plug 
it into the back of my computer. What do I do?

A You need to install another serial port into your system. 
The SLP connects to COM1, COM2, COM3, or COM4. 
You can use a switch box, but you may find it much 
more convenient—and less expensive—to have a serial 
board installed. 

Q The only available place to plug the SLP cable into the 
back of my computer is the opposite type. Should I get a 
gender changer?

A This is likely to be your parallel port connector. The SLP 
requires a serial port, and cannot be connected to a 
parallel port without a special adapter available 
separately from Seiko Instruments. See “Replacement 
Parts and Accessories” in Appendix D for ordering 
information.
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Q Can I hook my SLP into my serial port and then hook a 
mouse or modem into the other connection at the end of 
the SLP cable?

A No. Only one of the two connectors on the SLP cable 
can be used. The cable was designed so that it could be 
used on either a 9-pin serial port or a 25-pin serial port 
connector. 

The SLP is a serial device. Optimum installation 
mandates the use of a dedicated serial port. This means 
that nothing else in the computer is expected to use the 
same COM port or shared IRQ, for which the SLP is 
configured.

Unfortunately, if you install a new SLP on a serial port 
that has never been used before, that’s when you may 
learn of a malfunction with the serial port. If you can’t 
determine the cause of the problem, consult a qualified 
technician.

Another possible problem is that a serial device (such as 
a mouse, modem, tape backup card, scanner, home 
security system, network card, certain video card 
attachments, etc.) was previously installed on the 
computer without a check being made about which 
serial interrupts this new device uses. The new device 
might have been configured to use the same interrupts 
as the serial ports, causing a conflict. The solution for 
this problem is to have the new device board 
reconfigured to use only those interrupts that are 
available. A qualified technician may be needed to 
perform this task. 
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Technical Support is provided to assist with problems in the 
setup or use of your SLP. To assist us in best handling your 
support requirements, please review the following section.

Before You Call . . .

■ Check the Readme file that is included with the Smart 
Label program. This file contains the most up-to-date 
information about the Smart Label program.

■ Refer to the Troubleshooting topic in the on-line help. 

■ Review the commonly asked questions in Appendix B.

■ If you think a repair is necessary, follow the instructions 
in the following “Service for your Smart Products” sec-
tion. 

If you are not sure if your SLP needs repair, or if you have 
other technical support questions, please refer to the back 
cover of this guide for SLP Technical Support phone 
numbers.
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Service for Your Smart Products
How to get your Smart Label Printer repaired

In the unlikely event that your Smart Label Printer should 
require repair, please copy the Return Information Card at the 
end of this appendix and include it with your printer when 
you send it to our authorized repair center.

Returning your Smart Label Printer for repair is as easy as 1-
2-3!

1 Complete the Return Information Card.

2 Pack the product in a protective carton (like the original 
box). Include the Return Information Card in the box.

3 Ship the package to the repair center.

Repair Policies:
■ All products are repaired to original factory specifications.

■ All out-of-warranty repairs carry a 30 day warranty.

■ Products are usually repaired within 48 working hours of 
receipt by the repair center.

■ All products being returned for repair should be insured for 
full replacement value.
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Smart Label Printer Repair Center Locations in North America and Europe

North America

United States Canada

Seiko Instruments
Department ARC
25108 Milton Thompson Rd.
Lees Summit, MO 64086

GEAC Canada Ltd
45 Mcintosh Drive
Markham, Ont. L3R 8C7
Canada

Europe

Netherlands Switzerland 

Compac b.v.
Postbus 111
Hilversum
Nederland

Lab Plus AG
Kirchacherstrasse 9
Postfach 23
CH-8608 Bubikon
Switzerland

Sweden Finland

Memstore AB
Truckvägen 16
Box 2027
S-194 02 Upplands Väsby
Sweden

Paricad OY
Olarinluoma 16
FIN-02200 ESPOO
FINLAND

Germany

Papyrus Software-Entwicklung Gmbh
Spaldingstraße 74
D-20097 Hamburg
Germany

England, Scotland, Ireland

SEIKO Precision U.K.
S.C. House Vanwall Road
Maidenhead, Berkshire SL6 4UW
United Kingdom

Seiko U.K. Ltd.
Hattori House Vanwall Road
Madinhead, Berkshire SL6 4UW 
United Kingdom 

All other European Countries

Logistix Ireland, Ltd.
Attention: Seiko Repairs
Swords Business Park
Seaton Road
Swords, c/o Dublin
Rep of Ireland
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Return Information Card

Please place this card in with product being returned 
for service:

1.  Select the appropriate box:

❑    Warranty Repair
No charge. Must include dated proof of purchase.

❑    Out of Warranty Repair
Payment:     ❑  Check enclosed      ❑  Credit Card

(circle one)   VISA     MasterCard     AMEX (USA only)

Cardmember's Name (as it is printed on the credit card):
__________________________________________

Card Number: ______________________________

Expiration Date: __________________

Signature:  _________________________________

2.  Where should we send the repaired printer:

Company:
________________________________________________
Name:
________________________________________________
Address:
________________________________________________

________________________________________________
City, State, Zip:
________________________________________________

Phone:    (____) ______-____________
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SmartLabels for Smart Label Printers

*   Multilanguage packaging (German, French, Spanish)
** Available in North America only

Call us at 1-800-688-0817 (U.S. and Canada) or 0845-309-8028 (United Kingdom) for 
additional information or to place an order.

Visit our WEB site at http://www.seikosmart.com

Specifications subject to change.

SLP-2RL
SLP-M2RL*
SLP-1RLCL**
SLP-M2RLCL*

Address Labels
1-1/8" x 3-1/2" (28mm x 89mm), 2 rolls/box, 130 labels/roll
Clear Address Labels 1 roll/box, 130 labels/roll 
1-1/8" x 3-1/2" (28mm x 89mm), 2 rolls/box, 130 labels/roll

Colored Labels

SLP-CMB1

SLP-4AST

Combo Pack
1 roll each of white, clear, yellow, and blue file folder
Assorted Colored Labels
1 roll each of yellow, blue, green, and pink
1-1/8" x 3-1/2", (28mm x 89mm), 130 labels/roll

Custom Sized Labels

SLP-MRL

SLP-VSL

SLP-27210

1x2 Multipurpose Labels
1-1/8" x 2"  (28mm x 51mm), 2 rolls/box, 220 labels/roll
VHS Spine Labels
3/4" x 5-13/16" (19mm x 147mm), 2 rolls/box, 75 labels/roll
8mm Tape Spine Labels
3/4" x 2-13/16" (9mm x 71mm), 1 roll/box, 150 labels/roll

Additional SmartLabels for the SLP 220

SLP-2RLH
SLP-M2RLH*
SLP-SRL
SLP-MSRL*
SLP-2RLE
SLP-M2RLE*
SLP-DRL

SLP-VTL

SLP-35L

SLP-NR

SLP-NB

High Capacity Address Labels
1-1/8" x 3-1/2" (28mm x 89mm), 2 rolls/box, 260 labels/roll
Shipping Labels
2 -1/8" x 4" (54mm x 101mm), 1 roll/box, 220 labels/roll
Large Address Labels
1-1/2" x 3-1/2" (36mm x 89mm), 2 rolls/box, 260 labels/roll
3.5 Diskette Labels
2-1/8" x 2-3/4" (54mm x 71mm), 1 roll/box, 320 labels/roll
VHS Face Labels
1-13/16" x 3-1/16" (46mm x 78mm),1 roll/box,150 labels/roll
35mm Slide Labels
7/16" x 1-1/2" (11mm x 38mm), 1 roll/box, 300 labels/roll
Red Name Badge Labels
2-1/8" x 2-3/4" (54mm x 70mm), 1 roll/box, 160 labels/roll
Blue Name Badge Labels
2-1/8" x 2-3/4" (54mm x 70mm), 1 roll/box, 160 labels/roll
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Appendix D Ordering Labels and Parts

User Guide D-3

Replacement Parts and Accessories

The replacement parts listed below are available from Seiko Instruments. 
Call us at 1-800-688-0817 (U.S. and Canada) or 0845-309-8028 (United 
Kingdom) for price and order information.

Part Number Description

Body/Chassis Parts

32-81013-01 120 Label Roll Cover

32-81014-01 120 Label Spindle

32-81015-01 120 Print Engine Cover

32-82013-01 220 Label Roll Cover

32-82014-01 220 Label Spindle

32-82015-01 220 Print Engine Cover

Cables

34-83013-01 SLP 120/220 Power Cord, U.S. version

34-83014-10 SLP 120/220 Power Cord, Euro version

34-83015-50 SLP 120/220 Power Cord, UK version

34-83016-70 SLP 120/220 Power Cord, Australia version

34-83017-60 SLP 120/220 Power Cord, Japan version

34-83018-01 SLP 120/220 Serial Cable, PC

34-83020-01 Universal AC Adapter

Accessories

SLP-CNVTR Smart Label Printer Serial-to-Parallel Converter

SLP-SMRT Smart Label Printer Sharing Switch
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Index A — O

Index-2 Smart Label Printer Models 220 and 120

A
Accessories

ordering,  D-3
Address labels,  2-16

B
Bar code objects

adding,  2-15

C
Categories

creating or renaming,  2-16
selecting,  2-16

Changing a label roll,  3-3
Changing label format,  2-14
Changing label type,  2-20
COM port

changing,  2-12
connecting,  2-6

Common questions,  B-2
Contact information dialog box,  

2-15
Context menus,  2-18, 2-19, 2-20
Creating new labels,  2-13, 2-16, 

2-17

D
Developer information,  A-2

F
Features,  1-3
Find feature,  1-3
Format

applying,  2-14, 2-18
saving,  2-20

Format Text objects,  2-15
editing text,  2-18
inserting fields,  2-15
moving and resizing,  2-19

Frame objects
adding,  2-15

H
Help,  2-21

I
Importing

also see on-line Help,  2-11
labels from previous ver-

sions,  2-11
Installation

SLP 120/220,  2-4
Smart Label program,  2-10
updating a previous ver-

sion,  2-11

L
Label properties,  2-20
Labels

caring for,  2-3
recommended,  2-3, 3-2

Libraries
also see on-line Help,  2-11
selecting,  2-11

Loading labels,  2-7, 3-3
preparing a new roll,  2-7
removing the old roll,  3-3

M
Multiple users

also see on-line Help,  1-3

O
Objects

adding,  2-14, 2-19
bar codes,  2-15
deleting,  2-19
Format Text,  2-15, 2-18
frame,  2-15
modifying,  2-18
moving and resizing,  2-19
picture,  2-14, 2-19
properties,  2-18, 2-19
return address,  2-15, 2-18
selecting,  2-14, 2-18
Smart Text,  2-14

Other labels,  2-17
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Index P — W

User Guide Index-3

P
Package contents,  2-4
Picture objects

adding,  2-14
changing picture,  2-19
properties,  2-19

Printing labels
out of labels,  3-3
print button,  2-13
print selected labels,  2-17
SLP Print Manager,  2-17
stop printing,  2-17, 3-2

Properties
label,  2-20
objects,  2-18, 2-19

R
Repair center locations,  C-4
Replacement parts

ordering,  D-3
Return address objects

adding,  2-15
changing,  2-18
entering address,  2-18
properties,  2-18

S
Saved labels

finding,  2-13
importing previous version,  

2-11
printing,  2-17
recalling,  2-13

Saving format,  2-20
Saving labels,  2-13, 2-16
SLP

adjusting labels,  3-4
caring for,  3-2
connector pin asssignments,  

A-4
form feed button,  2-5
off-line mode,  3-2
on-line mode,  3-2
power button,  2-5, 3-2

removing stuck labels,  3-5
status light,  2-5, 2-6, 2-7, 3-

2, 3-3
testing printer,  2-9
thermal print engine,  3-2

SLP Print Manager,  2-17
Smart Label Icons,  2-14

customizing,  2-20
using,  2-18

Smart Label program
installing,  2-10
starting,  2-11

Smart Text objects
adding,  2-14
moving and resizing,  2-19

SmartCapture,  2-16
also see on-line Help,  2-13

SmartCopy,  2-13, 2-16
SmartLabels,  2-3, 3-2

Ordering,  D-2
Specifications,  A-2
System requirements,  2-2

T
Text Capture button

also see on-line Help,  2-13
Toolbar buttons

add bar code object,  2-15
add Format Text object,  2-

15
add frame object,  2-15
add picture object,  2-14
add return address object,  

2-15
add Smart Text object,  2-14
contact information,  2-15
new label,  2-13, 2-16
open label,  2-13
print label,  2-13
save label,  2-13, 2-16
select,  2-14

W
Windows 95 and 98,  2-2
Windows NT 4.0,  2-2
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Warranty Information

Limited Warranty on Hardware
One (1) Year Limited Warranty

Seiko Instruments USA Inc. warrants this product against defects in materials and workmanship for a period of one (1) 
year from the date of original retail purchase (proof of purchase required). If Seiko Instruments USA Inc. receives notice 
of such defects during the warranty period, Seiko Instruments USA Inc. will either, at its option, repair or replace 
products which prove to be defective.

Exclusions
The above warranty shall not apply to defects resulting from: improper or inadequate maintenance by customer; 
customer-supplied software or interfacing; unauthorized modifications or misuse; operation outside of the environmental 
specifications for the product; or improper site operation and maintenance.

Obtaining Warranty Service
To obtain warranty service, products must be returned to a service facility designated by Seiko Instruments USA Inc. 
See “Service for your Smart Products” at the back of this user guide for details.

Customer shall prepay shipping charges for products returned to Seiko for warranty service and Seiko Instruments USA 
Inc. shall pay for return of the products to customer. However, customer shall pay all shipping charges, duties and taxes 
for products returned to Seiko Instruments USA Inc. from another country.

Warranty Limitations
Seiko Instruments USA Inc. makes no other warranty, either expressed or implied, with respect to this product. Seiko 
Instruments USA Inc. specifically disclaims the implied warranties of merchantability and fitness for a particular purpose. 
Some states or provinces do not allow limitations on the duration of an implied warranty, so the above limitations or 
exclusion may not apply to you. However, an implied warranty of merchantability or fitness is limited to the one year 
duration of this written warranty. This warranty gives you specific legal rights, and you may also have other rights which 
may vary from state to state, or province to province.

Exclusive Remedies
The remedies provided herein are customers sole and exclusive remedies. In no event shall Seiko Instruments USA Inc. 
be liable for any direct, indirect, special, incidental or consequential damages, whether based on contract, tort, or any 
other legal theory. Some states or provinces do not allow the exclusion or limitations of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you.

Limited Warranty on Media

If you discover physical defects in the guide distributed with the Smart Label Printer, or on the media on which software 
is distributed, Seiko Instruments USA Inc. will replace the guide or media at no charge to you, provided that you return 
the items to be replaced during the 90-day period following your purchase of the Smart Label Printer or software.

All implied warranties on the media or guide, including implied warranties of merchantability and fitness for a particular 
purpose, are limited in duration to ninety (90) days from the date of the original retail purchase of the product.

Even though Seiko Instruments USA Inc. has tested the software and reviewed the documentation, Seiko Instruments 
USA Inc.  makes no warranty or representation, either express or implied, with respect to software, its quality, 
performance, merchantability, or fitness for a particular purpose. As a result, the software is sold as is, and you the 
purchaser are assuming the entire risk as to its quality and performance. In no event will Seiko Instruments USA Inc. be 
liable for direct, indirect, special, incidental, or consequential damages resulting from any defect in the software or its 
documentation, even if advised of the possibility of such damages. In particular, Seiko Instruments USA Inc. shall have 
no liability for any programs or data stored in or used with the Smart Label Printer, including the costs of recovering such 
programs or data. The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written, 
express or implied.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and 
you may also have other rights which vary from state to state.

Copy Protection
The Smart Label Printer program disks are not copy-protected. You may make backup copies for your own use, but this 
doesn' t mean you can make unlimited copies. The program is protected by the copyright laws that pertain to computer 
software. It is illegal to make copies of the disks without written permission from Seiko Instruments USA Inc.  In 
particular, it is illegal to give a copy of the program or your spare set of disks to another person.
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For best results, we recommend the use of
Seiko Instruments SmartLabels.

Other brands may not be engineered to provide
optimum, trouble-free results with your Smart Label
Printer; they may not work with your printer or they 

may damage it and void the warranty.

SmartLabels are available from your local Seiko Instruments dealer
or they may be ordered from Seiko Instruments. For information call:

1-800-688-0817 (USA and Canada)
0845-309-8028 (United Kingdom)

1130 Ringwood Court
San Jose, CA  95131 USA
www.seikosmart.com

User Guide
for Windows® 95, 98 and Windows® NT 4.0

Technical Support
North America
Germany
U.K.
France

1-800-757-1011 (6:00am-8:00pm Pacific)
+49-40-2380-8916
+44-17-157-15117
0800-901629 (in France only)

Models 220 and 120

Be sure to look for the Seiko Instruments SmartLabel logo
whenever you buy labels. SmartLabels are available

in a variety of sizes and colors so you can label
just about everything!

22-83000-03 Printed in China
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